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Available Tools

YHI Systems and Tools for Consumer Connectors

❑ Learning Management System (LMS)
• All PowerPoints and trainings

• Important dates

❑YHI Policy Manual, Code of Federal Regulations, State Regulations

❑YHI Website

❑Agency and Agency Staff Portals

❑Consumer support: support@yourhealthidaho.org  or (1-858-944-3246)

❑Consumer Connector support: connectors@yourhealthidaho.org 
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Available Tools

YHI Systems and Tools for Consumer Connectors

❑ Department of Health and Welfare (DHW)
• Idalink

• Authorized representative

• Notices

❑ PDAP

❑ Direct assistance
• Bobette Ostberg  (bobette.ostberg@dhw.idaho.gov)
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Available Tools

YHI Systems and Tools for Consumer Connectors

❑Consumer Connector Dashboard
• Designations

• Book of Business

➢ Download

➢ Filters

❑ Secure Inbox
• Agent Daily Summary
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Available Tools

Designation 

❑ Consumers working with Consumer Connectors must be advised to add the Consumer 
Connector as the designated Agent of Record (AOR).
• AORs must accept the designation in order to receive commissions or have access to support the 

consumer  via phone, email, or portals.



Book of Business 
Basics
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YHI Book of Business (BoB)

What is it?

❑Client management system 

❑ Formatted in a Microsoft Excel spreadsheet

❑Contains a list of your designated consumers

❑Contains data specific to the consumers’ YHI enrollment
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BoB Best Practices

Daily Downloads

Step 1. Log into your YHI Portal

Step 2. Click the “Individuals” drop down in the horizontal tool bar

Step 3. Select “Active Individuals”
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BoB Best Practices

Daily Downloads

A new page containing the list of active individuals in your Book of Business will populate

Step 4. Click the “Export as Excel” below the horizontal search bar to download your daily Book of 
Business report
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BoB Best Practices

Navigating Your Report

The report will indicate:
• Consumer’s name

• Consumer’s contact information

• Details about the household application 

• Details about the plan in which the consumer is enrolled
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BoB Best Practices

Tips and Tricks

❑ Navigating your BoB is much easier when you have the proper settings.

❑ The following slides will teach to how to adjust your spreadsheet for easier navigation, widen 
columns, filter data, temporarily hide information, and permanently remove unnecessary data.
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BoB Best Practices

Best Practices

Step 1. “Select All”
• Used to adjust the entire worksheet

• Click the diagonal triangle at the top left to highlight the entire spreadsheet

• Very cell will be highlighted except for the first cell
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BoB Best Practices

Best Practices

Step 2. “AutoFit”
• Use to evenly widen every column

• Click the “Home” tab

• Click “Format” in the top-right of the tool bar under the “Cells” section

• Select “AutoFit Column Width” in the drop-down menu
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BoB Best Practices

Best Practices

Step 3. “Pane Freeze”
• Use to keep the title row visible as you scroll throughout the spreadsheet

• Click any cell in the title row 

• Select the “View” tab above the tool bar

• Click Freeze Panes

• Select Freeze Top Row
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BoB Best Practices

Best Practices

Step 4. “Hide Data”
• Use to temporarily hide data you don’t need now, but may want later

• Click and highlight the column(s) or row(s) you wish to hide

• Right-click using your mouse to open the drop-down menu

• Select “Hide”

• To unhide, follow the same steps. Then, click “unhide”
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BoB Best Practices

Best Practices

Step 5. “Remove Duplicates”
• Use to remove duplicate households

• Follow steps to “Select All”

• Click the “Data” tab above the tool bar

• Click “Remove Duplicates” 
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BoB Best Practices

Best Practices

Step 6: “Remove Duplicates”
• Click “Unselect All” 

• Check mark the boxes next to the following data fields:

✓ Numbers

✓ First Name

✓ Phone Number

✓ Email

• Click “OK” when finished

Households with identical data in the above fields are often duplicates due to multiple policies 
(financial to non-financial)



Submit a Support 
Ticket
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Submit a Support Ticket to YHI

To submit a ticket to Support on the consumer’s behalf, locate their account on the active 
Individuals page. 
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Submit a Support Ticket to YHI

Hover over the options at the bottom of their account information, and then click Contact Your 
Health Idaho. A new support ticket opens.
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Submit a Support Ticket to YHI

Step 1. Click Request Type drop down and select “Issue”

Description
• Complaint – Complaints on resolved Casework

• Feedback – Process improvement 

• Issue – Primary use

• Triage – Don’t use
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Submit a Support Ticket to YHI

Step 2.  Click Request Sub-Type drop down and 

select  the appropriate category.

Description
• Technical Issue –YHI system technical error

• Enrollment Issue – APTC/CSR effective date 
and policy effective date/end date

• Billing Issue – Incorrect carrier billing

• General Issue – Other issue not defined

• Issuer Problem – Incorrect information with carrier not related to billing
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Submit a Support Ticket to YHI

Step 3. Click Priority drop down select “Medium”

Description
• Critical – Don’t Use

• High – Medically urgent cases

• Medium – Primary use

• Low – Don’t use
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Submit a Support Ticket to YHI

Step 4.  Subject – Brief 3-5-word summary of issue.

Description

✓ Application ID: Auto fills

✓ Applicant’s Last Name: Auto fills

✓ Applicant’s Date of Birth: Auto fills

✓ Last 4 digits of the Applicant’s SSN: Auto fill

• Describe the situation with as much detail as possible

• Enter steps taken to assist the consumer to this point

• Click Submit

A message of “Success” providing the Ticket Number 

for reference.



Designating an 
Agent of Record 
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Designation

❑ Consumer Connectors who set up the consumers account must designate themselves the Agent 
of Record (AOR) and accept the designation.

❑ Consumers working with Consumer Connectors must be advised to add a designated AOR.
• AORs must accept the designation in order to receive commissions or have access to support the 

consumer  via phone, email, or portals.
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How to Designate

Step 1. From the consumers dashboard Click “Find Local Assistance”

Step 2. Click “Find a Certified Agent or Broker Near You” 

or “Find a YHI Certified Enrollment Counselor Near You”

Note: To search for an Enrollment Counselor 
• search by Location or by Organization Name.
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How to Designate

Step 3. To locate an AOR, Search by Location or Search by Name
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How to Designate

Step 4. Click name of the agent in Blue 
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How to Designate

Note: The consumer must agree and check the following statements. 

Step 5. Click each check box and 

enter consumers name in the E-Signature.

Step 6. Scroll down to Click  Confirm.
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How to Designate

Step 7. Click “Close” 
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Accepting the Designation

Step 1. Log-in to Agent Portal

Step 2. Click Pending Individuals under “Quick Links”
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Accepting the Designation

Step 3. Click the consumers name in blue or gear under “Actions.” Clicking the gear Icon will allow 
to accept from a drop down.
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Accepting the Designation

Step 4. Click “Accept” 



YHI Appeal 
Process
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Submit an Appeal to YHI

If a consumer feels an error was made regarding their enrollment, 
they may file an appeal with YHI. 

Appeals to YHI should be filed within 30 days in order to 

be accepted as valid. This can be referenced in the YHI 

Policy Manual, “Insurance 31.”

Note: Each partner associated with YHI is responsible 

for reviewing different eligibility appeals (i.e.; DHW and carriers) 

YHI
• Marketplace Eligibility

• Open Enrollment & Special 
Enrollment Periods (SEP)

• Failure of Marketplace to 
issue timely determination

Contact: 1.855.944.3246
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Submit an Appeal to DHW

If the consumer has an appeal related to their eligibility determination 

for Cost Savings Programs including Medicaid, Children’s Health 

Insurance Program (CHIP), Advance Premium Tax Credit (APTC), 

or Cost-Sharing Reduction (CSR), call DHW at 1-866-883-8620. 

NOTE: This phone number should ONLY be used for consumers 

calling to disagree with their determination.

DHW
• Advance Premium Tax Credit 

(APTC)

• Cost Sharing Reductions 
(CSR)

• Medicaid/CHIP

Contact: 1.866.883.8620
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Submit an Appeal to Insurance Carriers

If the consumer has an appeal related to monthly 
premiums, claims covered or if coverage has been 
terminated due to nonpayment of premiums; reach out 
to the insurance carrier directly.

Insurance
Carriers

• Monthly Premiums and 
Payments

• Claims

• Discontinuation of coverage 
due to non-payment

Contact: Individual Carriers
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YHI Appeal Process

If the consumer has an appeal to submit to YHI, please follow the instructions outlined in the next 
slides.  

Consumer Connectors should exhaust all options with support@yourhealthidaho.org, the carrier, 
or DHW before filing an appeal. A good rule to follow is that either the Consumer Connector or the 
consumer has a denial of request in an email or phone conversation from 
support@yourhealthidaho.org before filing an appeal. 
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YHI Appeal Process

Go to https://www.YourHealthIdaho.org/filing-an-appeal 

1. Complete the web-based appeal for.
OR

2. Download the Appeal Request Form.
OR

3. Call 1-888-YH-IDAHO to complete an appeal request over the phone.
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YHI Appeal Process

❑ Fill out the Appeal Request Form 
• Add as many dates, contact names, and explanation as possible.

• Attach verification documents or communication history, if applicable. 

• Have the consumer sign the form.

❑ Scan and save the completed Appeals Request Form. If  the web-based form has been 
completed, a copy of the appeal request will automatically be sent to the email listed. 

❑ Submit the appeal to support@yourhealthidaho.org or mail it to Your Health Idaho.

❑ If the appeal is Medically Urgent, please indicate this in the subject line of the email submission 
or on the front page on a mailed form.

❑ If more information is needed for the appeal or if additional information is requested, reply to 
the original appeal email. 
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Status Updates for Appeals

❑ Once the appeal request is received at YHI, the Consumer Connector and consumer will receive a 
letter of receipt. 
• The Consumer Connector must be the designated on the account to receive appeal 

notifications/updates. 

• Per federal regulations, YHI must resolve the appeal within thirty (30) days of receipt.  

• Most YHI appeals are resolved within eight (8) days.

• If the appeal is Medically Urgent, you MUST make it clear in the original appeal. 

• Urgent appeals are resolved within three (3) business days, per YHI policy.

Note: If there is an appeal or DOI complaint pending on an enrollment, the account is frozen.  No 
actions may be completed until the resolution is processed. 

Do not call or try to make changes to an account that is in the appeal process. 
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Appeals Timeline Chart



DHW Financial 
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Process Overview

In 2020, approximately 78,000 Idahoans enrolled with YHI.

As part of the federally-required renewal process, YHI and DHW work to confirm that Idahoans:
• Receive an accurate redetermination of their eligibility for the Advance Premium Tax Credit (APTC) and 

Cost-Sharing Reduction (CSR)

• Maintain coverage without interruption into plan year 2021

• Have an opportunity to shop for a new plan for 2021, if they choose

The renewal process differs for consumers that are enrolled in coverage with tax savings applied as 
opposed to those who are enrolled without tax savings.
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Application Process

To apply for a new household, new person in an existing household, or report a change.

• Complete and apply through idalink at https://idalink.Idaho.gov
o Send supporting documents to Mybenefits@DHW.Idaho.gov with a note stating you have applied 

through idalink

• Complete and submit a paper application by:
o Emailing the documents to Mybenefits@DHW.Idaho.gov

o Faxing the documents to 1-866-434-8278

o Mailing the documents to:

Self-Reliance Programs Statewide Application Team

PO Box 83720

Boise, Idaho 83720-0026

Include all supporting documents upon application submission.

https://idalink.idaho.gov/
mailto:Mybenefits@DHW.Idaho.gov
mailto:Mybenefits@DHW.Idaho.gov
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DHW Operating Standards

Application

• Applications submitted through idalink are worked within two business days of submission

• If applications are emailed or mailed, the email or mail is processed within two business days 
of receipt. The application is then processed within five days after mail has been processed

Changes and Add-a-Person

• Changes and Add-a-Person submitted through idalink are worked within five days of the 
submission date

• If changes and Add-a-Person are emailed or mailed, the email or mail is processed within two 
business days of being received. Then the application is processed within five days after mail 
has been processed.

Calls

• For callers that have requested a call back, their call is returned by the end of the business 
day.
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Re-evaluation Process

DHW has recently moved from an annual re-evaluation process to a monthly process, as shown 
below. 



Application 
Linking



51



52

Application Linking

Application linking. 

• For new consumers, the path to create an account starts with YHI. 

Creating an account with YHI and DHW should reflect identical information.
✓ YHI - Primary account holder

✓ DHW - Primary account holder = Primary Tax filer = First consumer on the application

All demographics should be identical on both accounts. 



Step 1. Create an Account with YHI
• Pre-eligibility, Shop for Plans

• Add plan to cart

• Register

• Designate AOR

Step 2. Create an account with DHW 
• Register

• Designate AOR

• Process a financial application to determine:

• State offered program 

• APTC/CSR
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Application Linking



Step 3. Once the financial application is received from DHW, both AOR and consumer will receive 
notification to act. Enroll the member and make the binder payment.

Step 4. Carrier confirms enrollment and sends monthly updates through electronic data interface 
for reconciliation purposes

54

Application Linking
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What happens if the consumer doesn’t have an account with YHI and starts with DHW?

When an account is created with DHW and the application has been completed. The application 
will transfer to YHI creating the account, but the application will be unclaimed. The unclaimed 
application can be linked manually by YHI. 

Application Linking
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Updated Access Code Links

❑ Links to Access Code page are on the website! 

❑ There is now a button on the main (header) menu that will take you directly to the updated Access Code 
page. There is also a link on the image slider that redirects to the same simplified page. 

❑ Because of the new Access Code page has been simplified, the options to log in and shop for plans are no 
longer there. Instead, the Log In button has been updated so that when you click, you are taken directly to 
the username/password page. To shop for plans, click the Shop Plans button on the main slider.

❑ This will simplify and clarify the log in/access code process, especially for new users. 

Application Linking
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Access Code Link



Link a DHW 
Financial 

Application to a 
YHI Account
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Link an Application

❑ After the consumer applies for cost-savings, DHW makes the determination for eligibility. Once 
APTC eligibility is determined, DHW sends an account transfer to YHI (approx. 2-10 days).

❑ YHI sends the consumer a notification stating the APTC determination is received. The 
notification contains a link and an access code that links the information in the DHW account to 
the YHI account.

Important: If email is not selected as the preferred method of contact, only a paper notice is sent, 
which delays the notification process.
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Link an Application

This example shows the notification from Your Health Idaho for the consumer’s APTC 
determination. The consumer clicks or enters the link in a browser to open YourHealthIdaho.org. 
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Use the Access Code

Enter the access code from the notification, either from the front page of the website OR from the 
access code box on the login page.
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Verify Identity

The consumer answers verification questions, which can include their name, DOB, phone number, 
email address, gender, county of residence, and total members in household.
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Error: Could Not Be Processed Message

If the link is unsuccessful, an error message will appear. Email support@yourhealthidaho.org for 
assistance with any error you receive during this process and provide support with a screen shot of 
the error.



Plan Selection & 
Enrollment
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Shopping for Plans

Go to the consumer’s dashboard and click Shop For Plans. If a plan is selected but the process isn’t 
completed, it will show as “Favorite Plan” in the plan selection as opposed to Enrolled Plan.
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Shopping for Plans

Not Enrolled in Plan: The consumer should select  SHOP FOR PLANS and then follow the steps to 
finish enrollment with cost-savings eligibility.
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Plan Comparison 

If the member had coverage in the prior year and wants to compare prior year enrollment to 
current year options: 

Step 1. Click Shop for Plans.

On the plan selection page under 
Compare Plans shows the prior year plan. 

Step 2. Select plans and click Compare. 
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Plan Comparison 

To know the difference, the prior year will show the year, instead of ADD. 
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Eligibility Results

On the consumer’s dashboard, click View Details to view their household eligibility results.
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Ready to Enroll

Open the consumer’s dashboard and select the correct coverage year. Click Shop For Plan.
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Provide Additional Information

The consumer can provide additional information to view plans for which they are eligible. 
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Provide Additional Information

The consumer can provide additional information to view plans for which they are eligible. 
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Optional Questions

To check availability of in-network providers for plan selection of household providers, update 
information. 
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Optional Questions

The consumer answers doctor visits per year.



75

Optional Questions

To check availability in-network for plan selection of household prescription coverage needs, 
update information. 
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Optional Questions

The consumer can add up to 5 prescriptions to see plan coverage.
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Optional Questions

To check availability of Children's Dental and Acupuncture within plan availability.
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Select a Medical Plan

Shop, compare, and choose a plan that works for the consumer and their family.

Filter plans by plan type or monthly price, etc. Before finalizing a selection, it is important to review 
plan details carefully.
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Select a Dental Plan

After a consumer selects a medical plan, they can purchase a stand-alone dental plan. Stand-alone 
dental plans are available for children or adults. 
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Review Shopping Cart

Select a medical and/or dental plan to open the shopping cart. 

❑ The consumer can review their plan selections including effective date before singing the 
application.

Note: If you or the consumer does not complete the process, the plan selection is not complete. It 
will show as Favorite Plan on the dashboard when the you log into their account. 
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eSignature

Have the consumer carefully read the Terms and Conditions. Review the terms, and then enter the 
eSignature to complete the enrollment. 



82

Confirmation & Payment

The system prompts the consumer to pay for health insurance. Click Pay for Health Insurance to 
make the payment. The system redirects to further instructions on how consumers can make their 
payment. Payment instructions vary by carrier. 



Enrollment 
Verification 

For Tribal 
Members
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Proof of Tribal Membership

American Indians and Alaska Natives are eligible to receive specific ACA protections. For example, 
they can buy or change health insurance plans once a month through Your Health Idaho and are not 
subject to open enrollment periods. 

In order to confirm benefit eligibility, tribal members will be asked to verify membership status in a 
federally-recognized Tribe during the application process.

Verification documents can include the following:

• Tribal identification card

• Certificate of Indian blood

• Bureau of Indian Affairs form

Note: The Native American Service Center can be contacted for those who need assistance to 
prove American Indian status. 

. 
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Federally Recognized Tribes Exemption

Consumers might be granted an exemption by the marketplace or IRS if anyone in the tax 
household is a member of an American Indian Tribe or is eligible for health services through the 
Indian Health Service (IHS), Tribal organizations, or urban Indian organizations.

To get this exemption, consumers must indicate their Tribal membership on their application and 
submit documentation to prove their membership. 

. 
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Federally Recognized Tribes Exemption

This exemption is granted on a continuing basis and may be kept for future years without having to 
submit another application if there are no changes to membership in the Tribe or eligibility for 
services from an Indian Health Services provider.

Consumers may also claim this exemption when they file their federal income tax returns with the 
IRS.

To download the form, go to https://www.irs.gov/uac/about-form-8965

https://www.irs.gov/uac/about-form-8965


Disenrollment
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Disenrollment 

To disenroll an enrollee:

Step 1. Access the consumer’s dashboard (from agent or consumer account)

Step 2. Click View Details listed under “Your Health Plan” or “Dental Plan.”

On the next screen, select Disenroll From Plan.

Note: You may disenroll from health, dental, or both.
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Disenrollment Reason

The consumer is asked to confirm the reason for disenrollment, the termination date, and confirm 
the disenrollment.
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Plan Disenrollment 

The disenrolled policy will show on the consumer’s dashboard as Terminated. The consumer can 
only re-enroll in a new plan during Open Enrollment or if they qualify for a Special Enrollment 
Period (SEP). 



Ethical Standards
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Definition of Ethical Standards

The following standards are a set of guiding principles for Your Health Idaho consumer assistance:

❑ Consumer Connectors treat each consumer with respect, acceptance, and dignity

❑ Consumer Connectors don’t knowingly misrepresent applicant eligibility information 

❑ Consumer Connectors don’t knowingly misrepresent his/her capability to act as an Agent or 
Broker, nor fail to comply with certification standards

Note: YHI Consumer Connectors are committed by the Producer Agreement and the DOI Code of 
Ethics, both of which require the highest degree of ethical behavior and commitment to the best 
consumer experience. 
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Definition of Ethical Standards

Consumer Connectors protect the consumer’s right to privacy and confidentiality of their health 
and immigration status:

❑ Protect the integrity, safety, and security of consumer records in compliance with the Centers 
for Medicare & Medicaid Services (CMS) policies, procedures, and guidelines in the CMS 
Information Security and Privacy Overview “virtual handbook”

❑ Provide services without discrimination or preference based on age, ethnicity, culture, race, 
disability, gender, religion, sexual orientation, or socioeconomic status

❑ Respect individuals and groups and their cultures and beliefs

❑ Act with integrity, honesty, genuineness, and objectivity
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Definition of Ethical Standards

Consumer Connectors protect the consumer’s right to privacy and confidentiality of their health 
and immigration status:

❑ Responsibility is an essential element in ethics because it is built on understanding and 
respect of consumers’ needs. 

❑ Caring is the principle that enables Consumer Connectors to act in a consumer’s best 
interest. 

❑ Integrity inspires you to do the right thing regardless of the consequences. 

❑ Selflessness empowers you to directly serve consumers with patience and understanding.
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Best Interest of the Consumer

Always act in the best interest of consumers that you assist. This means that even if you have a 
relationship with a health insurance company that offers a health plans, you must aid consumers 
that focuses only on their best interests and not your own.

To act in consumers' best interests, help them choose health coverage that meets all their needs:

❑ Their ability to afford the health coverage

❑ Their health care needs, such as obtaining coverage of treatments for any health 
conditions that they have

❑ Their desire to keep a certain doctor or see doctors in a certain location

❑ Their families' health coverage needs, if applicable

.
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Accurate Description of the Marketplace

Consumer Connectors Might Be Required to:

Access information online to keep consumers informed while they make their decisions

AND

Establish operating procedures for finding information to effectively assist consumers (e.g., create 
a list of key resources and contacts)
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Accurate Description of the Marketplace

To act in consumers' best interests, follow these actions:

❑ Understand and educate them about health plan options

❑ Tell them about health plan options that best fit their budget and specific needs

❑ Use language assistance, cultural information, and materials that are accessible to consumers 
with disabilities

❑ Comply with all YHI privacy and security standards

❑ Conduct community outreach to learn more about your community's needs



Questions?

Contact Us!

Connectors
Email:  Connectors@yourhealthidaho.org
Phone: 1-855-944-3246

Congratulations! 

You have completed Module Five

mailto:Connectors@yourhealthidaho.org

